September 2019
Visit our website at www.pcs4me.com

Ken Johnson, Newsletter Editor

CAL ENDAR
SIG = Special Interest Group
September 21 - Saturday - 1:00-3:00 PM
General Meeting - Leader: Ray Carlson
Location: Prescott Public Library; Founders Suite A & B
First Hour: New Useful Malwarebytes Extension for Chrome and Firefox
During the first hour of the meeting, Ray will describe a new free extension developed by Malwarebytes to block
malware, scams, ads, trackers and other unwanted programs as you surf the web with Chrome or Firefox. Surfing
is supposed to be up to four times faster with this add-on. He will explain the installation of extensions while noting the risks recently identified with some add-ons. Finally, he will discuss the history of the Malwarebytes company and the recent success for their products in a malware protection competition.
Second Hour: Phil Ball will present Tips and Tricks with insights into various topics that assist with regular computer activity.
In addition to the presentations, the following are typical events which take place at our General meetings:
1) We hold an informal Flea Market in which you are encouraged to bring in your excess computer equipment or
software and make them available for others to enjoy at no charge. Please deposit give-away items on the table in
the back marked "Free Stuff." Any items left here at the end of the meeting are subject to disposal.
2) If you have items that are just too good to give away, you may set up a separate table and hold your own sale.
3) We conduct a free drawing for gift cards at the end of the meeting, so make sure to get a pair of tickets from
whoever is in charge and place one in the container provided.
4) We will also accept your used ink and toner cartridges for recycling. They are turned in to Think4Inc for credits
which PCS uses to purchase office supplies from them.
Future Meetings
September 24 - Tuesday - 10:00-11:00 AM
Technology Help Hour - Leader: PCS Staff
Location: Prescott Public Library Training Lab; Third Floor
Ask a technology question and get help from members of the Prescott Computer Society. Bring your own laptop or
mobile device or use a library laptop. This is a weekly drop-in service and registration is not required.
Calendar Continued on Pg 2
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September 28 - Saturday - 1:00-3:00 PM
Special Topics SIG - Leader: JB Burke
Location: Prescott Public Library; Founders Suite A & B
JB will discuss interesting topics related to general computing.
Note that these dates are correct at time of publication but are subject to change.
Up to date information can be found on our website, www.pcs4me.com
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Back to the Basics
Do you know these Google Icons?
By Jim Cerny, Forum Leader, Sarasota Technology Users Group, FL
May 2019 issue, The STUG Monitor

Page 3

be presented with several videos. It is amazing the
free videos you can find on YouTube!
D — Google MAPS – A great way to travel and get
from place to place. Probably better than the map
software used in your car. Plan your travels and
compare alternate routes. E — Google Translate –
Translate from one language to another, super easy
and super fun!
F — GMAIL – A great email app to do your email on
all your devices.
G — Google Play – Entertainment access to movies,
TV shows, books, music, and much more. Download
or use charges may be applied.
H — Google PHOTOS – Use the camera on your
smart phone and your photos will be uploaded to
Google Photos for you, freeing up space on your device. Now you can see and work with your photos on
any device.
I — Google Calendar – Keep all your appointments
here. Can be synced to your iPhone.

The above icons represent some popular Google
apps, do you recognize any of them? Write the
name of the app in the box. All these apps are
FREE with Google, all you need is a Google account. Still stuck on a few? Maybe you can match
a description below to the icon above. Of course
they are not in the same order, what would the
fun be in that? (The answers are at the end of this
article).
A— Google Earth -- Explore anyplace on the
planet, zoom in or out, take tours, and enjoy the
constantly improving 3D buildings and land formations. Absolutely dazzling!
B — Google DRIVE – Free software that works
like Microsoft Office – you get Google Docs (word
processing), Sheets (spreadsheets), Slides
(presentations) and more. You can also put
(upload) ANY of your files onto the drive to share
with others and have them available anywhere.
There is a small charge if you exceed the free 15
GB space amount.
C — YouTube – Now in the Google family. Search
and find videos on ANY topic or any famous person. See videos from the past or from other countries. Great for entertainment! When you do a
Google search on the internet you will most likely

J — Google Sheets (part of Google Drive) – Free
word processor similar to Microsoft Word.
K — Google Contacts – One place for all your contacts. Can be synced to your iPhone. L — Google
News – A great source for news.
L — Google News — A great source for news.
M — Google Slides (part of Google Drive) – Free
presentation app for creating great slides for your
talk similar to Microsoft PowerPoint.
N — Google Docs (part of Google Drive) – A great
free word processor similar to Microsoft Word.
Answers: 1-E 2-L 3-F 4-I 5-N 6-H 7K 8-J 9-C 10-G

Office 2019 and Changes to Office 365
By Nancy DeMarte, 1st Vice President, Sarasota Technology Users Group, FL
May 2019 issue, STUG Monitor
www.thestug.org / ndemarte (at) verizon.net
11-B 12-D 13-A 14-M Ω
Office 2019: Microsoft has been releasing new versions
of Office every three years for a long time. The newest
version, Office 2019, is now available in stores or online.
Continued on Pg 4
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Continued from pg 3:
The Home and Student edition for Windows 10 came
out in late September 2018. Office for MAC was released on March 3, 2019. The buyer pays one price,
which includes updated Word, Excel, and PowerPoint for installation on a single computer. If Office
2019 repeats the support pattern of earlier editions, it also gets regular security updates for ten
years, or until 2029. It is also touchscreen compatible.
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Translate – Located on the Review tab > Language
group in Word, Excel and PowerPoint, this feature
will translate a section of a document or the whole
document to one of several languages. Click the
down arrow below Translate to see the list of supported languages.

Included in Office 2019 are a few of the new features which had been available only to Office 365
users. Here are a few of them:
Icons – These scalable vector graphics are organized in a gallery of about 500 small black icons in 30
categories. Icons are located on the Insert tab in
Word, Excel, and PowerPoint. They can be
enlarged without losing image quality, colored, and
given special effects before being inserted into a
document, spreadsheet, or presentation.

Morph – This clever feature lets you animate a
group of objects in a PowerPoint slide. For information about how to set up Morph, click the Transitions tab in PowerPoint. Hover your mouse pointer
over Morph, read the information, then click “Tell
me More” for the full instructions. With a little
practice, it is easy to set up and is a crowd-pleaser.

Changes to Office 365 Home: Office 365 is the subscription version of Office. The Home version costs
$99.99 per year or $9.99 per month and has several bonuses. Office 365 Personal ($69.99 per year
or $6.99 monthly) has all the same bonuses as
Home, but for only one computer. Beware of the
much lower prices you can find on the Internet.
They are likely to give you a fake product.
Some changes in Office 365 took effect beginning
in October 2018. It appears that Office 365 is becoming more Internet-based than it was in the
past. Office 365 Home can now be installed on six
computers (Windows or Mac) plus other devices,
plus phones and tablets up to 10.1” screens. However, you can only sign into five devices at one
time. If you try to sign into a sixth device, you will
get a “limit reached” message and will have to sign
out of a device.
Signing into your Microsoft account is the only
way to activate Office 365. Once you sign in, Microsoft keeps you signed in until you sign out, with
a recommendation that you stay signed in on the
devices you use the most. If you sign out, you will
lose some Office features. If you have no Internet
connection, you will be able to use Office 365 for
30 days before being deactivated.
Each of the six installations still gets a terabyte
(1000 gigabytes) of cloud storage in OneDrive, the
Microsoft cloud storage area. You can access OneDrive from any computer at any location by signing into your Microsoft account. Office 365 also
gets monthly security and feature updates.
Continued on pg 5
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Continued from page 4
For those who want to have access to Office without buying the boxed version (Office 2019) or subscribing to Office 365, Microsoft also offers free Office Online to anyone who has a Microsoft account.
The online version runs in an Internet browser, but
editing is limited, and you cannot save files created
on the web to your computer. Another option is
installing the MS mobile apps for iOS or Android
phones and tablets, which currently are free for
home use.
Microsoft Office is a popular office suite. With the
several options available, depending on your need,
you can probably find a way to get this featurefilled suite. Ω

President’s Message Review - Grammarly
By Matt Batt, President, The Computer Club,
Florida
April 2019 issue, The Journal of The Computer
Club
www.scccomputerclub.org / mbatt453 (at)
gmail.com
Recently, I discovered a piece of software called
Grammarly. It reviews your writing and finds typos,
spelling errors and grammar mistakes. It’s quite effective. It's like a proofreader on steroids. Some
days, it’s quite humbling.

I installed the Grammarly desktop app
(www.grammarly.come/native/windows). The way to
use the desktop is to copy and paste what you
have written into Grammarly to be checked. Another option is to click on Import and upload a
Microsoft Word document directly into Grammarly.
I also installed the Microsoft Office add-in
(www.grammarly.com/office-addin/windows) so
that Grammarly was active for Microsoft Word
and Outlook.
My usage is simple. I use the Word add-in to
check documents that I write and the Chrome
add-in to check my emails. I won’t tell you how
many errors have been caught, but I’m very
happy that Grammarly is there for me.
I recently got to take a book that had been already published and proofread by professionals
and run it through Grammarly software. Grammarly pointed out many errors of style and some
serious grammar errors. Both the author and I
were very impressed.
Grammarly extensions are available for the
Chrome, Safari, Firefox and Edge browsers. It is
also available for both the iPhone and Android
platforms.
Try it, you’ll like it.Ω

Grammarly comes in a free or paid version. The free
version contains most of the features of the paid
version. The free version of Grammarly is more
than sufficient for the kind of writing that most of
us do with emails, letters, and articles. The paid version gives you an advanced grammar checker, a plagiarism detector and detailed information about
each of your grammar mistakes.

By Jerry Heaton, Editor, Central Kentucky Computer Society

There are several ways to install and use Grammarly:

j.heaton (at) ckcs.org

I installed Grammarly as an extension to my
Chrome browser. This is the easiest way to get
started with it. It is available from
www.grammarly.com. Once I installed it, Grammarly was available to check my emails that were
composed using the Gmail website online. This
chrome extension also works with other online
email and document editors.

I have used several speech recognition programs
over the years. I have tried

You may have a new speech recognition
program

May 2019 issue, CKCS Newsletter
www.ckcs.org

them all, and suddenly a new one showed up on
my computer and it is the best
one yet!

To provide you an example, all the text below
Continued on Pg 6
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I dictated using the new program.
After completing the dictation, I edited the text produced by my dictation following this pattern:
>In the paragraphs below, all the black words are the
result of my dictation.
>If I find a word I did not say, or a word misunderstood by MS speech recognition I will change the
black word to RED and draw a line through it.
>Any word I correct or added manually will be in
GREEN which I typed.There were a couple of places
improper grammar was substituted for what I said,
i.e. I said have and it entered had another time I said
pay and it used paid, etc.
All the black text below was dictated:
All of us using Windows 10 are very aware that periodically Microsoft updates the program and makes
changes the way things are done. Maybe I should
have said improvements and corrections instead of
changes. Nonetheless, that happens. I am also a sub
graber subscriber to Microsoft Office 365 for which I
paid pay an annual fee and get periodic updates and
corrections to it as well.
Today I wish to talk about a new feature that showed
up unexpectedly on my Microsoft Word ribbon bar.
Under the home tab they've added a section to the
right labeled voice and it's a small microphone under
which it says dictate.
Speech recognition is not new. The first demonstration I ever saw of it was in 1990 4 1994 at a Compulex
Show sponsored by CKCS in
downtown Lexington at the
Convention Center. That
product worked well at the
show but those that bought
the program Were were

greatly disappointed.
I have used speech recognition from time to time an
and each time I've tried it, it's better than before but
those still proved to be more trouble then than it was
worth since it made multiple errors in under-

standing what I said and secondly the thought
since it made multiple errors in understanding
what I said and secondly the thought process

I used of producing text is not always in the order
you would normally write that text. In other
words, I was not very skilled add at dictation.
This article is being dictated and I am not touching
the keyboard for any part of it. For speech recognition one should use a headset microphone. I had
one of those but have chosen to used use my microphone on my camera for this project. All I can
say is speech recognition program writers had
have come a long long way since those early days.
This is working remarkably well.
We are on paragraph 5 and all of this has been dictated without touching the keyboard.
I have noticed that this new microphone icon at
the right of the ribbon bar is also on Microsoft’s
outlook program which I use for email, as well as
PowerPoint.
It is obvious that if one is interested in getting a lot
of text quickly onto a page, speech recognition is
clearly the way to do that. The voice icon section
was added by Microsoft Office 365,.
If you find the voice icon on the above programs,
give it a try.Ω

